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Аннотация 
В данной работе была разработана программа для автоматизированного перевода данных из фор-

мата программного комплекса (ПК) Chemkin в формат ПК PrIMe (Process Informatics Models) мо-

делирования процессов горения. Одним из важных проблем моделирования химической кинетики 

процессов горения является проверка механизма на корректность описания исследуемого процес-

са. При решении таких проблем ПК PrIMe может предложить удобные инструменты для анализа. 

В связи с этим возникло необходимость создания конвертора форматов данных между программ-

ными комплексами. Эта программа поможет автоматически распознать данные из входного файла 

в формате ПК Chemkin и перевести, в считанные секунды, в формат ПК PrIMe. В создании ло-

кальной базы данных программы использовался сайт ПК PrIMe. Для хранения данных о свойствах 

реагентов и реакции в MS SQL Server созданы две таблицы, и эти таблицы заполнены данными, 

взятыми из сайта. Разработан алгоритм для автоматизированного чтения и распознавания данных 

из входного файла. С помощью разработанного алгоритма автоматизировано чтение и конверти-

рование данных из входного файла (в формате ПК Chemkin) на выходной файл (в формате ПК 

PrIMe). После разработки программы конвертора проводились работы тестирования, конвертируя 

разные механизмы в формат ПК PrIMe.  
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Введение 

 

В наши дни во многих областях науки и 

техники очень важны механизмы, которые 

смогут предварительно описывать химические 

процессы превращения. На сегодняшний день 

на земле 90% потребляемой энергии берется за 

счет процессов горения. Это обстоятельство и 

определяет важность и актуальность исследо-

вания процессов горения. В области модели-

рования существование механизмов для пред-

варительного описывания химических процес-

сов реальных топлив играет очень важную 

роль. Составление этих полных механизмов 

очень тесно связано с созданием и совершен-

ствованием экологически чистой и выгодной 

современной энергетической установки, без 

лишних затрат к экспериментальным исследо-

ваниям [1]. В связи с этими проблемами, для 

проведения вычислительных работ были раз-

работаны многочисленные программные обес-

печения. Среди них очень широко использу-

ются Fluent, CFX, FlowVision, Flow-3D, 

Chemkin. Эти программы предназначены для 

моделирования исследуемого химического 

процесса, и дают возможность понимания 

природных свойств данного процесса. Но мно-

гофакторная зависимость описываемого про-

цесса приводит к усложнению задачи модели-

рования. На сегодняшний день самые трудные 

вычислительные задачи с помощью суперком-

пьютеров решаются несколько часов, даже - 

несколько дней. В процессе решения таких 

задач ПК PrIMe является очень эффективным 

средством, т.е. для проверки входных данных 

и механизма изначально выбранной модели 

[2].  

Актуальным направлениям в исследова-

нии процессов горения является химическая 

кинетика. В химической кинетике рассматри-

ваются скорости и механизмы протекания хи-

мических реакций. 

Химическая кинетика решает две основ-

ные задачи: 

1) определение механизма реакции; 

2) количественное описание химической 

реакции. 

Механизм реакций состоит из совокуп-

ности последовательных элементарных ста-

дий, через которые проходит химическая ре-

акция от исходных веществ до конечных про-
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дуктов. Обычное уравнение реакции содержит 

информацию только о составе и количестве 

исходных веществ и продуктов, но не отобра-

жает реальных процессов, происходящих в 

действительности, т.е. не описывает элемен-

тарных стадий. Эти промежуточные единич-

ные процессы протекают по времени на про-

тяжении химической реакции и включают 

столкновение реагирующих частиц, разрыв 

связей в исходных веществах, образование 

промежуточных продуктов и взаимодействие 

между ними, возникновение новых связей и 

получение конечных продуктов. Включение в 

состав механизма всевозможных элементар-

ных стадий предоставляет возможность пол-

ноценного понимания процессов горения. С 

помощью механизма реакций исследуются из-

менение скорости реакции и концентрации 

веществ по времени и времена воспламенения 

пламени и т.д. По этим же характеристикам 

определяются оптимальные концентрации го-

рящих смесей по определенным целям исполь-

зования.  

В химической кинетике проверка досто-

верности механизма является одним из важ-

ным фактором исследования. Кроме того, со-

ставленный механизм не всегда может быть 

определен для широких диапазонов начальных 

условий и при изменении каких-либо парамет-

ров системы трудно сказать, что данный меха-

низм является достоверным и для этого про-

цесса. Поэтому, составление механизма про-

цесса предоставляет трудности для исследова-

телей. При проверке механизма ПК PrIMe яв-

ляется удобным инструментом анализа.  

PrIMe (Process Informatics Models) – сис-

тема для предварительного прогнозирования 

химической реакций, опирающиеся к научным 

парадигмам. Основной целью PrIMe является 

сбор информации в единую базу данных, про-

верка корректности этих данных и численная 

оценка ранее неизвестных данных. С помощью 

ПК PrIMe можно оптимизировать выбранный 

механизм с потребностями пользователя и 

сравнивать данные этого механизма с другими 

похожими данными, и определить механизм 

для предварительного описывания химическо-

го процесса [2].  

 

Программные комплексы Chemkin и PrIMe 

 

ПК Chemkin была разработана в 80-х го-

дах прошлого века. Это программное обеспе-

чение предназначено для специалистов, 

имеющих знание в области химической кине-

тики, и имеющих представление об идущих 

процессах. Для пользователей, не имеющих 

навыков работы с данной программой и не по-

нимающих об происходящих в них химиче-

ских процессах, работа с программой предос-

тавляет некоторые трудности. С появлением 

этого программного комплекса уже прошло 

более 35 лет и в этот период была собрана об-

ширная база химических механизмов, и ре-

зультаты вычисления ПК Chemkin вполне сов-

падали с результатами экспериментальных 

данных. Все это доказало надежность и досто-

верность используемого программного ком-

плекса и завоевало доверие своих потребите-

лей. На сегодняшний день этот программный 

комплекс развивается при поддержке компа-

нии Reaction Design. Последняя версия этого 

ПК Chemkin, называемая Chemkin Pro имеет 

вполне понятный интерфейс для пользовате-

лей [3]. 

Структура ПК PrIMe такова: PrIMe Data 

WareHouse - является складом данных, отно-

сящихся к области химии горения и для разра-

ботки прогнозирующих моделей горения. Со-

бранные здесь данные включают в себе термо-

динамические, транспортные свойства реаген-

тов и реакции, коэффициентов скоростей ре-

акции, а также результаты экспериментальных 

измерений. Данные, сохраненные в этих кол-

лекциях являются открытыми и собирают дан-

ные из всего мира для добавления в эту кол-

лекцию. Целью сбора этих данных является не 

только создание огромных параллельных кол-

лекций, но и непрерывное изменение старых 

данных, добавляя и сравнивая с новыми дан-

ными, и объяснение с научной точки зрения 

при изменении этих данных [2]. Этот про-

граммный комплекс разрабатывается в уни-

верситете Беркли (США, штат Калифорния) 

под руководством профессора Майкла Френк-

лаха, и с каждым годом совершенствуется. С 

помощью данного программного комплекса 

пользователь, не имея достаточное знание в 

области химической кинетики, сможет провес-

ти анализ механизмов химических процессов 

горения. 

В базе данных ПК PrIMe для каждой ре-

акции и участвующих в них веществ, назнача-

ется уникальный идентификатор. Используя 

эти идентификаторы пользователь сможет по-

лучить из базы термодинамические, транс-

портные и другие свойства искомого вещества 

или реакции. Хранение данных в таком виде 
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позволяет сохранить целостность и единство 

свойств химических веществ и реакций. Сис-

тема может сделать анализ собранных меха-

низмов в базе данных ПК и исключить меха-

низмы, которые не удовлетворяют определен-

ным требованиям (например, погрешность ре-

зультатов вычисления по сравнению с экспе-

риментальными данными). Принцип работы 

этого программного комплекса основан на веб 

службах. Пользователь, использующий эту 

систему для решения своих проблем, должен 

зарегистрироваться на сайте. Для решения 

своих задач пользователь сначала задает зна-

чение входных параметров и только после не-

скольких простых шагов начинается вычисле-

ние на сервере. После окончания расчетов ре-

зультаты возвращаются к пользователю в виде 

визуальных таблиц и диаграмм. По этим ре-

зультатам можно сделать анализ по опреде-

ленным целям. 

Текущие и будущие возможности ПК 

PrIMe и удобства использования при анализе 

больших механизмов показали необходимость 

перевода накопленных данных механизмов из 

формата ПК Chemkin в формат ПК PrIMe. До 

создания такого конвертора перевод данных 

между двумя программными комплексами 

проводился вручную пользователем, проверяя 

данные для каждого элемента и реакций из 

базы данных PrIMe. А сделать такую работу 

было очень трудоемким и занимала до не-

скольких месяцев. 

Для решения вышесказанных проблем 

была разработана «программа-конвертор», ко-

торая может за несколько простых шагов ав-

томатически переводить данные между про-

граммными комплексами. Эта программа на-

писана с использованием языка C# и с легко-

стью сможет переводить объемные механизмы 

из формата ПК Chemkin в формат ПК PrIMe. 

Механизмы ПК Chemkin сохраняются в 

файле по определенным правилам c расшире-

нием *.inp (Рисунок 1). Между ключевыми 

словами ELEMENTS и END записываются все 

химические элементы и изотопы, состоящие из 

одного или двух символов, разделенные между 

собой пробелами. Имя элемента или изотопа в 

списке должна встречаться только один раз, 

если не так, то она игнорируется при чтении 

данных из файла, за исключением первого 

значения. Названия элементов и изотопов мо-

жет записываться в нескольких строках, но 

они должны находиться между ключевыми 

словами ELEMENTS и END. 

 

 
 

Рис. 1 – Пример входного файла в формате ПК Chemkin 

 

После этого, между ключевыми словами 

SPECIES и END записываются названия всех 

реагентов, встречающихся на выбранном ме-

ханизме разделенными одним или более про-

белами. Названия реагентов не должны начи-

наться цифрами и символами ‘+’, ‘=’. Если 

реагент является ионом, то в конце названии 

реагента записывается знак ‘+’ или ‘-’. Иногда, 

в конце названия реагента может встречаться в 

скобках символ или буква, показывающая хи-

мическое состояние реагента. 
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Рис. 2 – Структура файла транспортных свойств реагентов Tran.dat 

 

В файле механизма между словами 

REACTIONS и END записываются все воз-

можные реакции в механизме, после каждой 

реакции в трех столбцах, разделенных пробе-

лами, записаны значения параметров коэффи-

циента Аррениуса, для вычисления скорости 

данной реакции. Символ «!» обозначает нача-

ло комментария в данной строке, все записан-

ные данные после этого символа в этой строке 

игнорируются. 

В ПК Chemkin при расчетах использу-

ются несколько файлов. Ими являются файлы 

Tran.dat, Therm.dat и Сhem.inp. В файле 

Tran.dat находится информация о транспорт-

ных свойствах всех реагентов в механизме 

(Рисунок 2).  

 

 
 

Рис.3 – Структура файла термодинамических свойств реагентов Therm.dat  

 

Внутри файла Therm.dat находятся тер-

модинамические свойства всех реагентов в 

механизме (Рисунок 3). Эти данные использу-

ются при вычислении термодинамических па-

раметров (теплоемкость, энтальпия, энтропия 

и т.д.) реагента.  

Для работы с ПК PrIMe реакционный 

механизм должен записываться с определен-

ной иерархической структурой в файле с рас-
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ширением *.xml. Одним из преимуществ этой 

системы от ПК Chemkin является то, что в ре-

акционном механизме записываются реагенты 

и реакции с определенными идентификатора-

ми. Для каждого реагента и реакции назнача-

ются некоторые идентификаторы, взятые из 

базы данных ПК PrIMe (Рисунок 4). С помо-

щью этих идентификаторов из базы ПК PrIMe 

берутся соответствующие термодинамические 

и транспортные свойства этих веществ и реак-

ций. Это значит, что нет необходимости в ис-

пользовании нескольких файлов вместе с фай-

лом механизма (Рисунок 2, 3), и ПК PrIMe 

предоставляя свои данные, может обеспечи-

вать целостность и единство данных. В базе 

данных данного программного комплекса хра-

нятся данные почти тысячи химических эле-

ментов и несколько десятков тысяч химиче-

ских реакций, взятых в результате детального 

изучения и оценки множества эксперимен-

тальных и расчетных данных. Поэтому, для 

конвертирования файлов между программны-

ми комплексами нам достаточно использовать 

файл механизма с расширением *.inp.  

 

 

 
 

Рис. 4 – Пример файла механизма ПК PrIMe 

 

Интерфейс программы-конвертора 

 

Интерфейс программы-конвертора, кон-

вертирующий данные из формата ПК Chemkin 

в формат ПК PrIMe, показан на рисунке 5. Ин-

терфейс программы организован простым и 

понятным для пользователей. Для перевода 

данных из формата Chemkin в формат PrIMe 

нужно выбирать пункт меню File → Open File 

и открыть целевой файл для конвертирования. 

Расширение входного файла может быть *.dat, 

*.inp или *.txt.  

После выбора нужного файла для кон-

вертирования все данные из входного файла 

копируется в левую часть интерфейса (Рису-

нок - 6). Для конвертирования в формат ПК 

PrIMe нужно нажать на пункт меню Convert 

→ ChemkinToPrIMe. После нажатия пункта 

ChemkinToPrIMe запускается процесс кон-

вертирования форматов данных. В ходе кон-

вертирования файла идет чтение данных из 

входного файла, если найдутся какие-то ошиб-

ки, то эти ошибки выводятся на всплывающем 

окне в виде сообщений. После окончании кон-

вертирования информация о ненайденных 

элементах или реакциях из базы данных про-

граммы выводятся на всплывающем окне в 

виде сообщений (Рисунок - 7).  

В ходе конвертирования программа чи-

тает данные из входного файла и распознает 

каждый элемент и реакцию, и сопоставляет к 

ним соответствующие идентификаторы из ба-

зы данных программы. База данных програм-

мы заполнена данными, взятыми из базы дан-

ных сайта [2]. В базе данных программы соз-

даны две таблицы. 
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Рис. 5 – Главный интерфейс программы Converter Chemkin to PrIMe 

 

 
 

Рис. 6 – Интерфейс программы после окончания работы конвертирования: входной файл (левая часть) 

и результат конвертирования (правая часть)  

 

В одной из них хранятся данные об 

идентификаторах веществ из базы данных 

PrIMe и на другой - о реакциях. Для просмотра 

этих данных нужно выбирать пункт меню 

Database → Species и Database → Reactions. 

И еще, в этих окнах просмотра можно добав-

лять, удалять или изменять информации о ве-

ществах или реакциях. 

Результат конвертирования выводится 

в правой части интерфейса программы в виде 

структурированной xml разметки. При необхо-

димости вы можете изменять эти данные пря-

мо из интерфейса программы. Данные о веще-

ствах в механизме ПК PrIMe записывается ме-

жду тегами <speciesSet> и </speciesSet>. Ин-

формация о каждом элементе в механизме пи-

шется между тегами <speciesLink> и 

</speciesLink>.
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Рис.7 – Окно сообщении о не найденных веществах и реакциях из базы данных программы  

 

Для каждого элемента определяется 6 

видов свойств. Эти свойства: 

• speciesLink primeID – является иденти-

фикатором каждого элемента в базе данных 

ПК PrIMe и название этого свойства начинает-

ся с буквы «s»; 

• speciesLink prefferedKey – химическая 

формула элемента, используется как предпоч-

тительный ключ поиска; 

• thermodynamicDataLink primeID – явля-

ется идентификатором термодинамических 

свойств элемента в базе данных ПК PrIMe и 

название этого свойства начинается с «thp»; 

• thermodynamicDataLink prefferedKey – 

предпочтительный ключ термодинамических 

свойств данного вещества, показывает из како-

го источника были взяты эти данные; 

• transportDataLink primeID – идентифи-

катор транспортных свойств данного вещества 

из базы данных ПК PrIMe и название этого 

свойства начинается с «tr»; 

• transportDataLink prefferedKey – свой-

ство, показывающее из какого механизма или 

источника были взяты данные о транспортных 

свойствах вещества; 

Данные реакций механизма находятся 

между тегами <reactionSet> и </reactionSet>. 

Информация о каждой реакции механизма 

пишется между тегами <reactionLink> и 

</reactionLink>. Для каждой реакции меха-

низма определяются 5 видов свойств. Эти 

свойства: 

• reactionLink primeID – идентификатор 

каждой реакции в базе данных ПК PrIMe и на-

звание этого свойства начинается с буквы «r»;  

• reactionLink prefferedKey – химическая 

формула данной реакции, используется как 

предпочтительный ключ поиска; 

• reactionLink reversible – свойство реак-

ции, показывающее двойную направленность 

реакции, значение «true» - реакция проходит в 

двухстороннем направлении, «false» - реакция 

проходит только в одном направлении; 

• reactionRateLink primeID – идентифи-

катор файла параметров скоростей реакций в 

базе данных;  

• reactionRateLink prefferedKey – свойст-

во, показывающее для каких реакций требуют-

ся эти данные. 

После конвертирования выходной ре-

зультат можно сохранить в отдельный файл с 

расширением *.xml с помощью пункта меню 

File → Save File → PrIMe File. Этот результи-

рующий файл можно вводить в базу данных 

ПК PrIMe.  

Дополнительные возможности про-

граммы конвертора: 

• Используя пункт меню Edit → Clear 

All → Input File (или Edit → Clear All → 

Output File) можно очистить все данные из 

левой (правой) области интерфейса програм-

мы; 

• Используя пункт меню Edit → Print → 

Input File (или Edit → Print → Output File) 

можно отправить на печать все данные из ле-

вой (правой) области интерфейса программы; 

• Программа конвертер выполняет поиск 

данных в левом или в правом окне с помощью 

«горячих» клавиш «Ctrl + F». 
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Заключение 

 

В результате была разработана програм-

ма конвертор для пользователей с удобным 

интерфейсом и автоматизированным перево-

дом данных из формата ПК Chemkin в формат 

ПК PrIMe (Process Informatics Models) модели-

рования процессов горения. Программа кор-

ректно читает и распознает данные из входно-

го файла ПК Chemkin и производит поиск по 

базе данных по распознанным объектам. При 

положительном результате поиска на выход-

ной файл записываются конвертированные 

данные искомого объекта (свойства реакции 

или реагента) с найденными свойствами. Ав-

томатизация всех этих работ дает возможность 

пользователю сэкономить время и не допус-

тить ошибок при конвертировании данных. 

Первоначально, программа конвертор разрабо-

тана для сотрудников института технологий 

горения Немецкого Аэрокосмического Центра 

и Штутгартского университета Германии с 

помощью предоставленного доступа к ПК 

PrIMe Майклом Френклахом, профессора де-

партамента инжиниринга механики Калифор-

нийского университета в Беркли США. 

В будущем планируется соединение к 

базе данных работающий с протоколом 

WebDav на формате данных HDF5 

(Hierarchical Data Format) и внедрение в эту 

систему, как одну из модулей данного про-

граммного комплекса.  
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CHEMKIN БАҒДАРЛАМАЛЫҚ КЕШЕНІНІҢ ФОРМАТЫНАН ЖАНУ ПРОЦЕСТЕРІН 

МОДЕЛЬДЕЙТІН PRIME БАҒДАРЛАМАЛЫҚ КЕШЕНІНІҢ ФОРМАТЫНА 

МӘЛІМЕТТЕРДІ АВТОМАТТЫ ТҮРДЕ АУЫСТЫРАТЫН КОНВЕРТОР БАҒДАРЛАМАСЫ 

 

Айтмұқаш Д. Б., Урмашев Б.А., Макашев Е.П. 

 

Түйіндеме 

Жұмыс барысында Chemkin бағдарламалық кешенінің (БК) форматындағы мәліметтерді және PrIMe 

(Process Informatics Models) БК форматына автоматтандырылған түрде ауыстыратын бағдарлама жа-

салынды. Жану процестерінің химиялық кинетика саласының негізгі мәселелері біріне механизмнің 

дұрыстылығын сараптау жұмыстары жатады. Оларды шешуде PrIMe БК ыңғайлы құралдар жиынын 

ұсына алады. Осыған байланысты бағдарламалық комплекстер арасындағы мәліметтер форматтарын 

ауыстыратын конвертер жасау қажеттілігі туындады. Жасалынған бағдарлама Chemkin БК 

форматындағы кіріс құжаттың ішіндегі мәліметті автоматты түрде танып және санаулы секундтар 

ішінде PrIMe БК форматына аударуға көмектеседі. Бағдарламаның локальді мәліметтер қорын құру 

үшін PrIMe БК сайты қолданылды. MS SQL Server – де реагенттер мен реакциялардың қасиеттері 

жайлы ақпараттарды сақтау үшін екі кесте құрылған және осы кестелер сайтынан алынған 

ақпараттармен толтырылған. Кіріс файлдағы мәліметтерді автоматты түрде оқып, тануға арналған 

алгоритм құрастырылды. Құрастырылған алгоритм көмегімен кіріс файлдағы (Chemkin БК 

форматындағы) мәліметтерді оқу мен оны шығыс файлға (PrIMe БК форматындағы) конверттеу 

жұмыстары автоматтандырылды. Конвертор бағдарламасы жасалғаннан кейін, әртүрлі механизмдерді 

PrIMe БК форматына ауыстыру арқылы бағдарламаны тестілеу жұмыстары жүргізілді. 

Түйінді сөздер: Бағдарламалық кешен, жану процестерін модельдеу, химиялық кинетика,  Chemkin 

БК, PrIMe БК, мәліметтерді аудару, жану механизмдері. 
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DEVELOPMENT OF THE PROGRAM CONVERTER FOR THE AUTOMATED TRANS-

LATION FROM THE DATA FORMAT SOFTWARE PACKAGE CHEMKIN TO THE DATA 

FORMAT SOFTWARE PACKAGE PRIME OF THE MODELING OF COMBUSTION 

PROCESSES 

 

Aitmukash D.B., Urmashev B.A., Makashev E.P. 

 

Abstract 

In this work developed a program for the automated translation the data format of software package (SP) 

Chemkin to the data format of SP PrIMe (Process Informatics Models) of the modeling of combustion 

processes. One of important problems of a chemical kinetics of combustion processes is verify this mecha-

nism to correctness for describe of the studied process. When solving these problems SP PrIMe can offer 

useful tools for analysis. Therefore, there was needs to creation data format convertor between software 

packages.  This program helps to automatically recognize data from the input file in format SP Chemkin and 

transfer this data, in a few seconds, to the SP PrIMe format. In the creation a local database of this program 

used website of SP PRIME. For storage data about properties of reagents and reaction in the MS SQL Server 

created two tables, and this tables filled with data taken by from the site. Developed an algorithm for 

automaticaly reading and recognizing data from the input file. By using this algorithm automated reading 

and converting of data from input file (in the format SP Chemkin) to the output file (in the format SP PrIMe). 

After development of the converter program conducted test works by converting different mechanisms to the 

PrIMe SP format. 

Keywords: software package, modeling of combustion processes, chemical kinetics, SP Chemkin, SP 

PrIMe, data conversion, combustion mechanisms. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


